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Abstract

There is growing interest in the link between axonal cargo transport and age-associated neuronal
dysfunction. Studying axonal transport in neurons of adult animals requires intravital or ex vivo
imaging approaches, which are laborious and expensive in vertebrate models. We describe simple,
non-invasive procedures for imaging cargo motility within axons using sensory neurons of the
translucent Drosophila wing. A key aspect is a method for mounting the intact fly that allows
detailed imaging of transport in wing neurons. Coupled with existing genetic tools in Drosophila,
this is a tractable system for studying axonal transport over the lifespan of an animal and thus for
characterising the relationship between cargo dynamics, neuronal ageing and disease. Preparation
of a sample for imaging takes approximately 5 minutes, with transport typically filmed for 2-3
minutes per wing. We also document procedures for quantifying transport parameters from the
acquired images and describe how the protocol can be adapted to study other cell biological
processes in ageing neurons.

Introduction

Many cellular processes depend on the trafficking of organelles, vesicles and
macromolecules by cytoskeletal motors. Neurons are particularly dependent on long-range
cytoskeletal transport because of their remarkably elongated processes. It is therefore not
surprising that defective axonal transport has been implicated in the pathogenesis of several
age-related neurodegenerative diseasesl. However, studying the relationship between axonal
transport and the structure and function of the nervous system during ageing is challenging.
This is chiefly due to difficulties in visualising transport within an adult animal.

Experimental systems have been described for imaging axonal transport in the nervous
system of adult mice, which use either surgical procedures in whole animals2-5 or tissue
explants6. Each of these methods is technically demanding and several involve invasive
procedures. The long lifespan of mammals is a further challenge when studying the
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relationship between axonal transport and neuronal ageing. Here we describe a simple, non-
invasive method for detailed characterisation of axonal transport in the intact nervous system
of the fruit fly, Drosophila melanogaster. This system utilises the translucent adult wing to
generate high quality image series of axonal cargo transport at different stages of adulthood.
Importantly, the method can be combined with sophisticated genetic tools to study neurons
that either lack or have reduced levels of specific proteins, or carry the equivalent of human
disease mutations. This is therefore a tractable system for genetic and cell biological studies
of how axonal cargo dynamics contribute to age-related neuronal dysfunction.

Development of the protocol and comparison to other methods

Third instar larval motor neurons of Drosophila have been used extensively for axonal
transport studies because of the ability to combine fly genetics with detailed imaging of
cargo dynamics (e.g. Refs. 7-9). However, this developmental system is not well suited for
studying the relationship between axonal transport and neuronal ageing. We therefore sought
to develop a protocol that allows detailed imaging of axonal transport in adult Drosophila.
Our choice of the adult Drosophilawing was inspired by the publication of procedures for
live imaging of sensory neurons within this system10-12. These methods were designed to
visualise injury-induced axonal degeneration and have provided important insights into this
process.

In the wing, the neurons are located within the costal vein and the longitudinal veins 1 (L1)
and 3 (L3)13-15 (Fig. 1a). In the L1 vein, the neuronal cell bodies are located at the anterior
wing margin, and are connected by short dendrites to mechanosensory and chemosensory
bristles (Fig. 1b). The L3 vein contains fewer neurons, the sensilia of which are located in
the proximal segment of the vein. The axons within each of the wing veins bundle together
and project into the thoracic ganglion of the animal13-15.

One method for live imaging of wing neurons involves mounting whole flies in a block of
agarosel1,16. Although this procedure is suitable for axonal injury studies, we find that it is
not compatible with detailed analysis of cargo transport within axons. Such analysis requires
high magnification, high numerical aperture (NA) objectives. Because these objectives have
a short working distance, they cannot be routinely used to visualise cargoes within the wings
of flies mounted in an agarose block. Moreover, the agarose-based embedding procedure is
time consuming (25-30 min per preparation), laborious, and subjects the tissue to large
changes in temperature (incubating with 55°C agarose and cooling to 4°C or on ice). These
temperature changes are likely to have consequences for cytoskeletal transport processes
(e.g. microtubules depolymerise whilst kept at cold temperatures17,18). Wings that have
been removed from the body of the fly have also been used for injury studies11,12. Unlike
the agarose-block based method, this procedure makes it straightforward to mount wings
flat, which facilitates imaging of the wing neurons. However, we have found that the
dissection process leads to a rapid decline in mitochondrial transport in the axons of the
wing neurons. Thus, this method is also not suitable for live imaging of axonal transport.

Our experiences with these preexisting methods led us to develop a new protocol that allows
detailed visualisation of axonal cargoes within the wing sensory neurons of an intact fly
(Fig. 1c, d). Whole flies are immobilised in a custom imaging chamber, which can be
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quickly and easily constructed from coverslips and adhesive tape. Within each chamber, the
most of each wing lays flat against a coverslip in halocarbon oil. Spinning disk-based
imaging of these preparations produces high quality image series of axonal cargo transport.
Overall, the mounting and imaging process takes less than 15 minutes per fly. We have also
optimised procedures for extracting transport parameters from the image series.

Overview of the protocol

Our protocol consists of several different steps (Fig. 2). The first step is the generation of
adult flies that express in wing neurons markers of specific cargoes that undergo
microtubule-based transport. A range of fluorescent protein markers for axonal cargoes has
been produced, with a large majority available through the Bloomington Drosophila Stock
Center (Indiana University, IN; see also Table 1). Expression of the fluorescent protein is
typically achieved with the binary Gal4/UAS expression system19 because of the large
number of transgenic lines available. However, the orthogonal /exA/lexAop expression
system20 can also be used effectively in wing neurons (see ‘Experimental design’ and
‘Anticipated results’ sections).

At each time point in the experiment, individual flies are mounted in the custom imaging
chamber. Image series are promptly captured from these preparations and exported into open
source software for manual tracking of cargo trajectories and subsequent extraction of
transport parameters. The procedure can be repeated with flies at different stages of
adulthood in order to evaluate transport dynamics during the ageing process.

Applications of the method

The major use of this method is the analysis of axonal transport in an adult model organism.
Cohorts of flies can be collected from the same culture and aged for different lengths of time
before imaging. This allows cargo dynamics to be characterised at a fixed time point or
throughout the ageing process. We recently published a study that made extensive use of this
protocol21. The study included the observation that the matility of mitochondria in wing
neurons of young flies was comparable to the motility of these organelles in Drosophila
larval motor neurons and the sciatic nerve of young mice. We also discovered that there is a
boost and gradual decline in the frequency of mitochondrial movement within the axons of
wing neurons during adult life. These changes did not reflect general changes in cargo
transport, as the motility of dense-core vesicles was not altered over this period.

Importantly, the method can be combined with the sophisticated genetic tools previously
established by the Drosophila community. It is possible to analyse how specific mutations
affect transport processes by combining them with transgenes that mark cargoes
fluorescently21. New mutations, including null mutations and single amino acid
substitutions, can be generated rapidly using CRISPR/Cas9 genome engineering22,23. This
affords the user many possibilities for functional studies, such as assessing how mutations
that are associated with human neurological diseases affect axonal transport.

When mutations are not compatible with development of the fly to adult stages, or when it is
important to discriminate cell autonomous and non-autonomous effects, tissue-specific
analysis of gene function is possible through expression of RNAI constructs with Gal4/
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UAS21. These RNAI constructs are available to the community from genome-scale
collections24,25 and it is straightforward for a user to generate additional RNAI constructs
for the same gene in order to control for potential off-target effects. If necessary, the timing
of RNAI expression can be restricted using a temperature sensitive version of the Gal4
repressor, Gal80 (Gal80%)21,26,27. In these cases, it may be desirable to express fluorescent
cargo markers using the /exA/lexAop system so that labelling is not under the same temporal
control as the RNAI construct. Genetic stocks are also available to make fluorescently
marked wing neurons that are homozygous for genetic mutations12. This provides an
additional method to analyse the function of genes that have important roles in other
Drosophila tissues.

In principle, the throughput of the assay also lends itself to pharmacological methods for
manipulating protein function. Small molecule agonists or antagonists can be fed to flies by
incorporation into yeast paste or fly food medium, followed by assaying the effects on cargo
transport in wing neurons.

Finally, the ease of sample preparation and quality of imaging data afforded by the protocol
means that it can be adapted to study other aspects of neuronal cell biology with high spatial
and temporal resolution, including how these processes are influenced by changes in axonal
transport. For example, we previously described fluorescent markers that can be used to
assess age-associated focal protein accumulations in ageing neurons21. These can be used to
correlate changes in transport processes with alterations in neuronal protein homeostasis.
Expression of genetically encoded calcium sensors28,29, in combination with mechanical or
chemical stimulation of wing margin bristles21,30, is a promising method for assessing
neuronal activity during ageing and how it is altered by perturbations that influence
transport. It should also be possible to use established fluorescent sensors of other cellular
processes, such as oxidative stress31,32, in wing neurons.

Manual tracking of single vesicles and organelles is time-consuming. Unfortunately, this is a
common drawback for studies of cargo transport in different cell types. Although highly
desirable, a reliable “‘universal’ method for automated particle tracking is currently not
available. This is because tracking methods must be tailored to deal with sample specific
differences such as signal-to-noise ratio, and cargo shape and density33-35. Currently, open-
source software for automated tracking is unable to accurately measure transport parameters
when applied to the wing neurons. Future efforts will be aimed at developing software that
can perform this task.

A more specific drawback of the wing neurons is that, because of cuticular structures,
immunostaining of whole-mount samples is not possible, at least with currently available
protocols. However, a growing number of fluorescent markers is being generated by the
Drosophila community, which will increase the versatility of our method. As described in
Table 1, we have recently generated additional marker strains in our laboratory. Efficient
genome editing in Drosophilaby CRISPR/Cas9 and novel libraries of fluorescently tagged
proteins (e.g. Ref. 36) will accelerate the production of fluorescent protein markers
expressed at physiological levels.
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Experimental design

Choice of fly strains (Step 1)—Table 1 documents a number of Gal4/UAS and /exA/
lexAop strains that we have found are suitable for use with our protocol. The different Gal/4
and /exA driver strains differ in the proportion of neurons within the wing in which they are
activel1,12,14,21. Using a widely expressed driver together with an abundant cargo, such as
mitochondria, can result in large datasets that increase statistical power. However, the
density of cargoes in these genotypes means that accurate tracking of trajectories can be
challenging and time-consuming. In this protocol we highlight some examples of transgene
combinations with which we work routinely. However, the user should determine which
transgenes are preferable for their specific needs.

Culturing flies (Steps 2-5)—Wherever possible, care should be taken to avoid changes
in diet or environmental conditions during fly culture, as these could influence experimental
outcomes. Thus, the food composition and preparation procedure should be kept constant
during an entire study, with cohorts of control and experimental genotypes raised in parallel
using the same batches of food. The temperature (25 + 1°C) and humidity (50 + 3%) of our
fly room is tightly controlled to minimise environmental changes.

Mounting of a fly in the imaging chamber (Steps 8-19)—The use of halocarbon oil
is critical. The viscosity of the oil stabilises the body and the wings of the animal. This oil
also allows diffusion of gases and, with a refractive index similar to glycerol, is an excellent
choice for imaging studies37. We have used No. 0, No. 1 or No. 1.5 coverslips to construct
the imaging chamber, and all give high quality images. We have noticed, however, that
sealing the imaging chamber with an upper No. 1.5 coverslip occasionally results in damage
to the fly. This is presumably due to excessive pressure exerted by this rigid coverslip. We
therefore use No. 0 or No. 1 glass as the upper coverslip. The type of coverslips used to
construct the chamber should be kept constant throughout each study to ensure consistent
imaging. Although it is possible to mount several flies in each chamber, we advise against
this practice as some flies will recover fully from the anaesthetic before imaging is
complete; strong movements of the animal can affect the stability of the wing preparation
and thus compromise imaging.

We typically expose a single fly to CO, for 4-5 minutes before mounting in the chamber in
order to ensure long-term anaesthesia, followed by prompt imaging of wing neurons. In
order to evaluate if long-term exposure to CO, affects transport in wing neurons, we
performed control experiments in which flies were anaesthetised for only 20-30 seconds
(the minimum time required to immobilise the fly and check wings for damage) before
mounting and then allowed to recover from the anaesthetic for ~ 5 minutes prior to imaging.
As expected, several preparations could not be used due to excessive movement of the fly.
However, those preparations suitable for imaging had similar transport characteristics to
those observed with longer CO, exposure (Supplementary Fig. 1). Thus, prolonged CO»
treatment does not appear to affect transport processes in wing neurons.

Imaging (steps 7 and 20-28)—The use of high-magnification (60x or 100x), high
numerical aperture objective lenses with apochromatic and flat field correction is crucial for
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obtaining high quality image series of cargo transport. We typically use a 60x objective
because, compared to the 100x, it has a relatively large depth-of-focus and field-of-view. A
spinning disk imaging system is a critical part of the protocol, as this allows rapid, high
signal-to-noise imaging of cargo transport in the wing with negligible photobleaching. Use
of a laser scanning confocal microscope (e.g. LSM 780, Zeiss) at the same acquisition rates
results in much noisier images that are not suitable for tracking cargo dynamics, and also
causes substantial photobleaching. Several types of high quality spinning disk-imaging
systems are commercially available, and it is likely that all of these can be used with this
protocol for detailed analysis of cargo dynamics. Although most spinning-disk systems have
an inverted configuration, it is also possible to use an upright configuration by flipping the
orientation of the imaging chamber on the microscope stage.

The user should devote time to choosing optimal image acquisition settings for each
fluorescent marker. These settings may need to be adjusted when expressing the same
fluorescent protein with different drivers, as these will activate the target promoter to
different degrees. Low frame rates can result in high signal-to-noise images that facilitate
accurate assignment of cargo location in individual frames. However, if frame rates are too
low, fine details of motion (e.g. short pauses and brief changes in direction) can be missed.
Phototoxicity and photobleaching should also be taken into account when determining the
acquisition parameters. Motility and morphology of mitochondria were not affected when
the period of continuous imaging was extended to up to 30 min with our standard spinning
disk acquisition parameters. We also did not observe a substantial amount of photobleaching
of mitochondrial signals over this period, although bleaching may be more of an issue with
cargoes that are bound by a small copy number of a fluorescent marker protein. We
recommend choosing settings that allow the highest acquisition rate that is compatible with
accurate tracking of motile cargoes throughout an image series.

The choice of the region of the wing to image has a large effect on the type of data
produced. Imaging of neurons in the costal vein is challenging. Because the axons of these
neurons bundle in close proximity to the thorax, they often do not lay flat against the
coverslip. We therefore exclusively image the L1 or L3 veins. We favour imaging the arch
region of L1 (Fig. 1a, c) because all the axons of this vein are collected in this segment.
Thus, a large number of cargoes can be analysed from each movie. It is possible to image
regions with fewer axons, for instance the region of the L1 vein in the distal part of the wing
margin or the L3 vein (Fig. 1a, d). Having fewer cargoes per movie can simplify the tracking
process, which can be beneficial when abundant cargoes are marked using a driver that is
active in a large proportion of wing neurons. Once an area of the wing has been selected, it
should be used throughout a study to control for any regional variation in transport
dynamics.

The user should be aware that darkly pigmented regions of the wing, including the edge of
the wing margin, are autofluorescent. However, this is not a substantial obstacle because
these regions generally do not overlap with signals from axonal cargoes.

Ageing studies (Step 6, 29)—To analyse cargo transport at different stages post-
eclosion, a cohort of flies is used that is collected from the same culture on the same day.
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Typically, 6-10 flies are imaged for each condition (e.g. mutant and control genotypes) on
each day of the experimental series. Although flies survive the mounting and imaging
procedure and can be returned to culture vials, the residual oil means that wings often
become folded or stuck to the body of the fly. It is therefore not practical to use the same
flies for imaging on subsequent days. Because the variance in cargo transport dynamics
between individual flies is small, other flies from the same cohort can reliably be used at the
later time-points. In cases where it is desirable to image the same fly at a later time point —
for example to evaluate cellular responses to a specific injury — the agarose-block mounting
method11,16 may be preferable. This protocol allows extraction of the fly from the chamber
and imaging for a second time, albeit with a risk of some flies dying or incurring damage to
the wing11,16.

Quantification (Steps 30-39)—Kymographs cannot be used to accurately assign
transport trajectories for abundant cargoes such as mitochondria due to the complexity of the
traces produced. For consistency, we therefore use manual tracking of all cargoes in a study
that includes analysis of abundant cargoes. Toggling back-and-forth between consecutive
frames in the image series usually allows confident assignment of individual cargoes with
this method. The ImageJ plugins MTrackJ38 and Manual Tracking (Fabrice Cordeliéres,
Institute Curie, France) are well suited for manual tracking of image series. The two plugins
offer different options in terms of data output, track recording and display. We favour
MTrackJ for the more extensive array of parameters recorded.

A transported cargo is operationally defined as one containing at least one continuous
movement of = 2 pm, which we term a ‘run’. The start of a run is marked when a motile
cargo enters the axonal segment or moves from a stationary position or into the focal plane
for the first time. The run is terminated when the particle reaches the end of the axonal
segment, stops or moves out of the focal plane. Anterograde and retrograde runs are those
directed towards the thorax of the fly and the cell body of the neuron, respectively. We
previously demonstrated that the microtubules in the axons of the wing neurons have a
classical orientation, with plus ends extending away from the cell body21.

. Transgenic flies for expressing the desired fluorescent marker protein in
wing neurons (Table 1)

. ‘Iberian’ fly food (see Reagent Setup) Note that our protocol will also be
compatible with other fly food recipes.

. Yeast (Saccharomyces cerevisiae, Type 11, Sigma-Aldrich, cat. no. YSC2)
. Glucose (Formedium, cat. no. GLU03)

. Agar (Drosophila Agar Type I, Dutscher Scientific, cat. no. 789150)

. Organic plain white flour (BigBarn CIC, UK),

. Tegosept (Dutscher Scientific, cat. no. 789130) see Reagent Setup
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Propionic acid (Sigma-Aldrich, cat. no. P1386)
Penicillin-Streptomycin (ThermoFisher Scientific, cat. no. 15140-122).
\oltalef 10S halocarbon oil (VWR, cat. no. 24627.188)

Absolute ethanol (Sigma, cat. no. 32221)

Spinning-disk microscopy for time-lapse live imaging

Inverted fluorescence microscope (Olympus 1X71)
Spinning disk imaging system (UltraVIEW ERS, PerkinElmer)

Charge-coupled device (CCD) camera with 1344 x 1024 pixel chip (Orca
ER, Hamamatsu)

Mercury-Arc light source (Osram)
488 nm, 561 nm, 631 nm laser system (Melles Griot)

60x/1.4 NA and 100x/1.4 NA PlanApo oil-immersion objectives
(Olympus)

Stage-mounted slide clips (Olympus)
Piezo objective positioner/scanner (Physik Instrumente) for z-stacks

Immersion oil (e.g. Immersol 518F oil (Zeiss))

Confocal microscopy for acquisition of z-stacks (optional)—For end-point
phenotypic analyses when time resolution is not crucial (e.g. quantifying protein
aggregates), a laser scanning confocal microscope can also be used to acquire zstacks.

Confocal microscope (e.g. LSM 780, Zeiss)
63x/1.4 NA PlanApo oil-immersion objective (Zeiss)

Immersion oil (e.g. Immersol 518F oil (Zeiss))

Software for image acquisition and quantification of transport

ImageSuite software (PerkinElmer) for spinning disk system and ZEN
software (Zeiss) for laser scanning confocal microscopy system

ImageJ (Wayne Rasband, NIH, USA) (open source)

ImageJ plugins: Straighten (Eva Kocsis, NIH, USA), StackReg (Philippe
Thévenaz, EPFL, Switzerland), Image Stabilizer (Kang Li, Carnegie
Mellon University, USA), Cell Counter (Kurt de Vos, University of
Sheffield, UK), MTrackJ38, Manual Tracking (Fabrice Cordeliéres,
Institute Curie, France) (all open source). Manuals for the use of the
plugins are available at http://rsbweb.nih.gov/ij/plugins/.

Excel (Microsoft)

Nat Protoc. Author manuscript; available in PMC 2017 March 01.


http://rsbweb.nih.gov/ij/plugins/

s1duosnuBIA Joyiny sispund DN edoin3 ¢

s1dLIOSNUBIA JoLINY sispund DN 8doin3 ¢

Vagnoni and Bullock

Page 9

. Prism (GraphPad)

Other equipment

. Disposable vials (Regina Industries, cat. no. P1066) and bungs (Genesee
Scientific, cat. no. 59-201) for fly culture

. Electric table-top kettle (Cleveland Range, cat. no. KET-12-T) for
preparation of fly food

. Dumont no. 5 fine forceps (Fine Science Tools, cat. no. 11251-20)

. Paper labelling tape (VWR, cat. no. 817-0027) and double-sided Sellotape
(Banner Business Services, cat. no. 0603015) for constructing imaging
chamber

. Coverslips No. 0 (22 x 64 mm, Scientific Laboratory Supplies, cat. no.

MIC3208), No. 1 (22 x 64 mm, Scientific Laboratory Supplies, cat. no.
MIC3228) or No. 1.5 (22 x 64 mm, Scientific Laboratory Supplies, cat.
no. MIC3248) for assembly of the imaging chamber

. Paint brushes (ProArte, Prolene Plus Series 007, Size 3/0, cat. no.
50655182)

. Carbon dioxide supply for anaesthetising flies

. Dissecting stereomicroscope (e.g. Leica MZ7.5) for mounting

anaesthetised flies in the imaging chamber

. (Optional) 215 automatic Liquid Handler (Gilson, cat.no. 2510121) for
aliquoting fly food.

Reagent Setup

Tegosept stock solution—Dissolve 50 g of Tegosept powder in 500 ml of absolute
ethanol (Sigma, cat. no. 32221) to give a 100 mg/ml stock solution.

‘Iberian’ fly food—70 mg/ml yeast, 55 mg/ml glucose, 7.7 mg/ml agar, 35 mg/ml organic
plain white flour, 1.2 mg/ml Tegosept, 0.4% (vol/vol) propionic acid, 100 U/ml Penicillin-
Streptomycin. For a 5 L batch; Heat 3 L tap water to ~ 110°C using an electric table-top
kettle; Add 275 g glucose and 350 g yeast, stir the mixture and boil for 15 min; Stir 38.5 g
agar into 800 ml room temperature (~ 22-23°C) tap water and add to the hot glucose/yeast/
water mixture; Stir the mixture and boil for 20 min; Add 175 g flour to 800 ml room
temperature tap water, stir and add to the previous agar/glucose/yeast/water mixture; Stir the
mixture and boil for 30 min; Add room temperature tap water to a final volume of 5 L; Cool
mixture to between 55°C and 60°C; Add 60 ml Tegosept stock solution, 20 ml propionic
acid and 50 ml Pen/Strep solution (10,000 U/ml), followed by mixing; Decant into culture
vials manually or using a 215 automatic Liquid Handler. Allow solution to set and top each
vial with a bung. Store fly food at 4°C for up to two weeks and warm to room temperature
before use.
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Imaging chamber—The imaging chamber can be partially assembled as described in
Steps 13 and 14 of the *Procedure’. Partially assembled chambers can be kept indefinitely in
a coverslip box until required.

Procedure

Fly husbandry. TIMING typically 10-66 days after setting up the parental crosses

1

2|

3]

4

5|

6|

Cross male and virgin female flies to produce progeny expressing fluorescent
markers in wing neurons (see Table 1).

CRITICAL STEP Crosses should be designed so that the flies that will be
imaged do not contain genetic markers that strongly affect wing morphology
(e.g. CyOhalancers). Such markers necessitate unnatural flattening of the wing
during mounting, which can damage the tissue and thus compromise the
transport process.

CRITICAL STEP In order to reach meaningful conclusions, there must be
sufficient agematched flies for statistical comparisons between the control and
experimental conditions. When only a proportion of the offspring will have the
desired genotype, the scale of fly crosses should be increased accordingly.

Maintain the crosses at 25°C with a 12-h-light/12-h-dark cycle. If temperature
sensitive experiments are performed (e.g. control of transgene expression via
the Gal4 repressor Gal80%) rear the flies at the appropriate temperature.

Closely monitor the fly cultures so as not to miss the day when the first adult
flies eclose.

Transfer newly emerged flies of the desired genotype to a vial with fresh food
at the end of the day using standard Drosophila handling procedures. Record
which day each cohort of flies eclosed.

CRITICAL STEP Do not collect too many flies in a single culture vial as
overcrowding can increase the rate of lethality (we usually keep < 20 flies per
vial, with males and females cultured in the same vial).

If necessary, collect newly emerged flies on subsequent days at the same time
to establish additional cohorts. Alternatively, collect flies every 8-12 h for fine-
grained analysis of transport properties.

CRITICAL STEP During the first 24-48 hours after eclosion from the pupal
case, transport dynamics of at least some cargoes in the wing nerve change
dramatically21. We therefore recommend collecting cohorts of flies every 8-12
h during this period. It is also possible to mount flies of newly eclosed flies as
soon as the wings unfold21.

For ageing studies, carefully transfer the flies into vials with new food once or
twice per week following anaesthetisation with CO,.
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CRITICAL STEP Regular transfer of flies to new vials minimises the risk of
wings being damaged by contact with fly food that has been churned up by
larvae.

Preparation for imaging, assembly of the imaging chamber and fly mounting TIMING
typically less than 10 min.

7]

8|

9

10|

11

12|

13|

Turn on the laser, mercury light source, microscope and acquisition software.
Rotate the objective turret so that the desired objective is positioned below the
stage opening. Set the acquisition parameters in the software.

CRITICAL STEP Ensure the temperature of the room is kept constant as
cellular processes, including the activity of microtubule motors, may be
sensitive to any changes in this parameter. The temperature of our microscope
room is maintained at 21-22°C by the building’s environmental control
system.

Anaesthetise the flies from the desired culture on a CO, pad. See
Supplementary Video 1 for a demonstration of steps 8-19.

Using a stereomicroscope, inspect flies for any abnormalities in their wings
(e.g. cuts, blisters or folds).

Choose a single fly without wing abnormalities for imaging and return the
other flies to the food vial.

CRITICAL STEP The sex of the fly imaged for each movie should be
recorded so that potential sex-specific outcomes can be evaluated later (note
that the dynamics of mitochondrial transport are indistinguishable in male and
female flies21).

Keep the selected fly on the CO, pad for 4-5 min.

CRITICAL STEP If necessary to ensure long-term anaesthetisation, flies can
be treated with CO», for longer. The user should check that the animal survives
extended treatment with CO, and should keep the anaesthetisation conditions
constant within the same experimental series.

Gather the equipment needed to assemble the imaging chamber (Fig. 3a—f).
The first part of the chamber assembly (Steps 13 and 14, Fig. 3a—c) can be
completed during the anaesthetisation process. For convenience, part built
chambers (Fig. 3a and b) can be prepared in advance.

Make a stack of three layers of paper labelling tape on each of the short sides
of a coverslip (Fig. 3a). Each piece of labelling tape has dimensions of ~ 15
mm x 7 mm. The labelling tape stacks act as spacers for the imaging chamber.

CRITICAL STEP The number of layers required in the stacks can vary
depending on the thickness of the batch of labelling tape. An appropriate stack
thickness ensures that the fly is lightly restrained once the chamber is sealed
with an upper coverslip, such that the legs are prevented from moving without
the body of the animal being damaged by excessive squeezing.
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Add a single layer of double-sided tape to each of the two stacks of labelling
tape, as well as to the centre of the coverslip. This latter piece is aligned with
its long axis perpendicular to the long axis of the coverslip (Fig. 3b). When
part-built chambers are made in advance, the paper layer protecting the outer
adhesive part of double-sided tape should not be removed until the chamber is
needed.

Use a paintbrush to apply a thin coat of 10S halocarbon oil to a small region of
the coverslip adjacent to the central piece of double-sided tape (Fig. 3c).

Following the anaesthetisation period, pick up the fly by gently holding the
legs with the forceps. Lower the fly towards the coverslip with the dorsal side
leading.

Apply the fly to the region of coverslip with the halocarbon oil so that the
dorsal side of the head is gently pressed against the central piece of double-
sided tape and the dorsal side of the rest of the fly is positioned against the
glass (Fig. 3d). The double-sided tape helps stabilise the fly during imaging.
Make sure the wings are extended away from the thorax, lying completely flat
against the coverslip. If this does not occur naturally, the position of the wings
can be adjusted very carefully with a paintbrush (see Supplementary Video 1
for an example).

CRITICAL STEP Apply just enough oil for the wings to remain attached to
the coverslip. Excessive oil will prevent the entire wing from abutting the
coverslip, which leads to problems with focusing and sample drift during
imaging.

CRITICAL STEP We advise against using glues, such as Dermabond 2-octyl
cyanoacrylate39, to stabilise the wings. Glues can affect the integrity of the
thin wing tissue, resulting in detrimental effects on axonal transport.

? TROUBLESHOOTING

Gently apply a thin layer of halocarbon oil on top of the wings with a fine
paintbrush.

CRITICAL STEP Be careful not to damage or stretch the wings during this
process. Too thick a layer of oil can lead to wings lifting up from the coverslip.

? TROUBLESHOOTING

Seal the chamber by attaching a second coverslip on top of the two tape stacks
at either end of the first coverslip (Fig. 3e). To do so, apply by hand one end of
the upper coverslip to one stack and gently lower the other end of the upper
coverslip on top of the second stack. Once loosely applied, press the upper
coverslip gently above the positions of the tape stacks.

CRITICAL STEP The pressure exerted on the upper coverslip should be just
enough to restrain the movement of the fly’s legs. Applying excessive pressure
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may damage the fly. Uneven pressure on the upper coverslip may cause the fly
to tilt sidewise, in which case it may not be possible to image transport.

Imaging TIMING usually less than 10 min per fly

20|

21

22|

23]

24|

25|

Carefully pick up the imaging chamber by hand and promptly transfer it to the
room containing the spinning disk imaging system attached to an inverted
microscope (in our case, this is adjacent to the sample preparation room). Add
a small amount of immersion oil to the 60x or 100x objective and position the
imaging chamber above the stage opening with the lower coverslip (i.e. the one
supporting the wing) facing the objective. We secure the imaging chamber with
stage-mounted slide clips, but adjustable slide holders can also be used.

Use the X-Y translational controls on the stage to position the fly above the
objective, using the bright-field configuration to locate one of the wings in the
eyepieces. Inspect the wing for signs of damage that may have been missed at
the stereomicroscope. Image the other wing if damage to the first wing is
found. If both wings are damaged, discard the chamber and return to step 8.

CAUTION Because excessive pressure of the objective can lead to fracture of
the chamber, the fine focus adjustment should be used when the objective is
close to the surface of the imaging chamber.

Find the desired area of the wing using landmarks shown in Fig. 1a (see
‘Experimental Design’ for the advantages and disadvantages of imaging from
different regions).

CRITICAL STEP Film the same region of the wing for an entire
experimental series in order to control for region-specific differences in
transport parameters.

Position the microscope filters to allow fluorescence imaging with the
wavelength appropriate for the cargo marker. Adjust the focus based on the
fluorescent signal.

? TROUBLESHOOTING.

Turn on the “‘Acquisition” mode of the imaging software. Re-adjust laser
intensity, exposure time, camera gain and the size of the imaging window if
necessary. Keep imaging settings constant for an experimental series.

? TROUBLESHOOTING.

Initiate time-lapse image acquisition with continuous illumination and a total
capture time as desired. We routinely image mitochondrial transport (e.g. using
apr-Gal4, UAS-mito..GFP or Appl-Gal4, UAS-mito..GFP) for 3 min with a
capture rate of 0.5 frame/s and the transport of faster cargoes, such as dense
core-vesicles (e.g. using Appl-Gal4, UAS-ANF::EMD), for 2 min with a
capture rate of 1 frame/s.

? TROUBLESHOOTING
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Repeat steps 21-25 for the other wing of the mounted fly, provided visual
inspection reveals no damage. In our experience, there are no overt differences
in transport dynamics between the first and second wing that is imaged.

Discard the chamber at the end of imaging in accordance with local safety
protocols.

Repeat steps 8-27 for several flies on the same day.

For ageing studies, repeat steps 7-28 on additional days using flies from the
same cohort.

Quantification of transport TIMING variable, depending on the dataset; 20—40 min per
movie is typical for a dataset with a large number of cargoes (e.g. 50-60/frame)

30|

31
32|

33|

34|

35|

36|

37|

Export image series from the imaging system’s computer to the analysis
station.

Open an image series in ImageJ.

If the image series has been exported as multiple frames, use the ‘Images to
Stack’ function to create a stack (Image -> Stacks -> Images to Stack).

If necessary, use the Straighten plugin to straighten any axonal curvature
(Plugins -> Straighten).

If the sample has drifted in the X-Y plane during imaging, stabilise the
straightened image with the StackReg or Image Stabilizer plugin (Plugins ->
StackReg or Plugins -> Image Stabilizer).

Crop all images in the image series to the same area for consistency. We
routinely quantify transport from an axon segment of 50-ym in length. If
desired, kymographs can be plotted using the Kymograph Creator function of
Imagel.

Track transported cargoes with MTrackJ (Plugins -> MTrackJ). Manually
determine the start and end of each run and use the plugin to determine the
cargo’s centroid position at each point. Use the Cluster tool in MTrackJ to
group different categories of motion (e.g. anterograde, retrograde and
bidirectional cargoes) so they can be evaluated separately in steps 38 and 39.
Adjust the brightness and contrast of the movie while manually tracking as this
helps follow dim particles.

CRITICAL STEP Track all motile particles that are visible in the image
series to avoid any sub-conscious bias that could occur if a subset of particles
is randomly selected for analysis.

? TROUBLESHOOTING

Use the Cell Counter plugin (Plugins -> Cell Counter) to mark the total
number of particles from a representative frame. This value is used to calculate
the percentage of the population that is motile.
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CRITICAL STEP When adjacent organelles are very close or touching,
toggle back-and-forth between neighbouring frames in the image series to
identify whether single or multiple particles are present at a specific point.

38| Export the recorded dataset into Excel and calculate the desired mean values (+
errors) per cargo per wing. We routinely evaluate the mean and distribution of
velocities and run lengths (anterograde and retrograde), as well as the mean
number and percentage of motile cargoes.

39| Export the datasets created in Excel into Prism in order to generate graphs and
perform statistical analyses. Use a post-hoc correction method for multiple
comparisons when performing statistical evaluations with several groups.

? TROUBLESHOOTING

Troubleshooting

Timing

Troubleshooting advice can be found in Table 2.

Steps 1-6 and 29: Timing depends on the time of eclosion and the age of the flies analysed;
typically 10-66 days after beginning parental cross (based on eclosion from the pupal case
10 days after egg laying at 25°C and longitudinal studies of up to 8 weeks)

Steps 7-19: Typically 5-10 min.
Steps 20-28: Typically less than 10 min per fly

Steps 30-39: Timing depends on the dataset; 20-40 min per movie for a dataset with a large
number of cargoes

Anticipated Results

By following the mounting and imaging procedures in this protocol, we can routinely
visualise axonal transport dynamics with high spatial and temporal resolution. The quality of
the image series allows accurate manual tracking of cargo trajectories, which can be used to
evaluate changes that occur at different stages of the animal’s lifetime and in specific genetic
backgrounds. The mounting procedure that we present in this protocol is also suitable for
super-resolution microscopy, as demonstrated by the structured illumination microscopy
(SIM) image in Supplementary Fig. 2.

Fig. 1c, d and Supplementary Videos 2 and 3 show representative examples of wing neurons
with GFP- or mCherry-labelled mitochondria, which were captured with spinning disk
microscopy. The quality of images also allows other dynamic events to be captured, such as
mitochondrial fission and fusion (Fig. 4; Supplementary Videos 4 and 5). Fig. 1c and d and
Supplementary Videos 2 and 3 illustrate the difference in the number of cargoes in a field of
view when imaging the arch region of the L1 vein and the L3 vein. As described in
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‘Experimental Design’, imaging the L3 vein is an option when the high density of cargoes in
the arch region makes tracking of an entire image series challenging or time-consuming.

As also described in ‘Experimental Design’, an alternative strategy for manipulating the
density of cargoes in a field of view is the use of drivers that are expressed in only a subset
of sensory neurons within the L1 vein. For example, the expression patterns of apr-Gal4and
0k371-Gal4 are more restricted than those of the pan-neuronal drivers such as elav-Gal4,
Appl-Gal4 and nSyb-lexA. Fig. 5a provides an example of different densities of fluorescent
cargoes when imaging the same region of the wing with a restricted (gpr-Gal4) and more
widespread (App/-Gal4) driver line.

The importance of choosing an appropriate driver line for specific experimental situations is
further exemplified in Fig. 5b and Supplementary Video 6. The presence of a closely linked
UAS-GFPtransgene on the dpr-Gal4 chromosome makes it very challenging to track small
cargoes that are labelled with a green fluorescent fusion protein (e.g. GFP, YFP or Emerald).
This is because the background fluorescence from the UAS-GFP masks the fluorescence of
the cargo marker (Fig. 5b). This is not an issue when imaging mitochondria with dpr-Gal4,
presumably as these organelles contain many copies of the fluorescent marker protein. The
use of an alternative driver is therefore recommended for tracking small cargoes labelled
with green fluorescent proteins (Fig. 5¢ and Supplementary Video 7). Alternatively, small
cargoes can be marked by red fluorescent proteins (e.g. RFP or mCherry) under the control
of apr-Gal4 (Fig. 5d and Supplementary Video 8).

In summary, the protocol presented here is a simple and versatile method for analysing
axonal transport in the context of an ageing animal. Coupling the imaging procedures to
established genetic tools in Drosophila has the potential to provide important insights into
the relationship between axonal transport and the function of adult neurons, including in the
context of ageing and disease.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Figure 1. Imaging organelle transport in the nervous system of the adult Drosophila wing.
(a) Cartoon of the Drosophila wing showing the position of the costal and longitudinal veins

(L1-L5). The nervous system is highlighted in green. Boxes highlight regions imaged in b—
d. (b) Cell bodies and processes of L1 vein neurons. Green, cell membranes; red, nuclei
(genotype is Appl-Gal4>mCD8::GFF, RedStinger::NLS). Arrowheads, dendrites; arrows,
bundled axons. (c) Still image of GFP-labelled mitochondria in axons of the wing arch
region of a dpr-Gal4>mito::GFPfly one day after eclosion (from Supplementary Video 2).
(d) still image of mCherry-labelled mitochondria in axons of the L3 vein of a nSyb-
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lexA>mCherry::mito fly two days after eclosion (from Supplementary Video 3). Images in
b—d were captured with spinning disk microscopy using the procedures described in the
protocol (b, zstack projection; ¢ and d, single focal planes). Scale bars: 5 pm.
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Set up crosses to produce
flies expressing fluorescent
cargo markers in wing neurons
(Steps 1-3)

Collect cohort of flies shortly
after eclosion and age
(Steps 4-6 and 29)

v

At the desired day post-eclosion,
mount individual flies in a custom

chamber using halocarbon oil (~ 5 min) <

(Steps 8-19)

Live imaging of axonal transport by
spinning disk microscopy (2-3 min/wing)
(Steps 7 and 20-28)

Post-acquisition quantification by
manual particle tracking (timing variable)
(Steps 30-39)

Figure 2. Overview of the experimental procedure.
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As detailed in the ‘Procedure’ section, the total experimental time is variable depending on
how long the flies are aged after eclosion and the number, length and complexity of the

movies that need to be tracked.
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Figure 3. Key steps in the preparation of the imaging chamber
(a) Two stacks of labelling tape (orange) are attached to a coverslip. (b) A single layer of

double-sided tape (marked by arrows) is added to each of the two stacks of labelling tape, as
well as to the centre of the coverslip. (c) Halocarbon oil is applied to a small region of the
coverslip (arrow). (d and inset) The fly is mounted dorsal side down on the coverslip, with
the head stuck to the double-sided tape and the wings extended over the surface of the glass.
(e and inset) A second coverslip seals the chamber, gently pressing against the fly. See
Supplementary Video 1 for more details of these procedures. (f) Photograph of a wing
mounted in the chamber. Wing veins are labelled as in Fig. 1a.
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(on

a Fission Fusion

dpr-Gal4>mito::GFP dpr-Gal4>mito:.GFP

Figure 4. Visualisation of mitochondrial fission and fusion events in wing neurons.

Still images showing examples of mitochondrial fission (a) and fusion (b) in the L1 vein of
apr-Gal4>mito::GFPflies (taken from Supplementary Videos 4 and 5, respectively). (a) A
stationary GFP-marked mitochondrion (red arrow) undergoing fission. The newly generated,
motile mitochondrion is marked by a yellow arrow. (b) Example of mitochondrial fusion
between a motile (red arrow) and a stationary (yellow arrow) mitochondrion. The orange
arrow marks the newly generated mitochondrion, which is motile. Scale bars: 2.5 um.
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a dpr-Gal4>mito::GFP

[15s
5um
Retrograde Anterograde

Figure 5. Representative results with different combinations of drivers and cargo markers in
wing neurons.

(a) Still images of GFP-marked mitochondria using apr-Gal4 (top panel) and App/-Gal4
(bottom panel), illustrating the increased number of mitochondria visualised with the latter,
pan-neuronal driver. (b, ¢) Illustration of the importance of choosing an appropriate driver
strain when imaging small cargoes labelled with green fluorescent proteins. Top images in b
and ¢ show a still image from Supplementary Videos 6 and 7, respectively, in which the
dense-core vesicle marker prepro-atrial natriuretic factor peptide (ANF)::Emerald (EMD) is
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expressed with apr-Gal4 (b) or Appl-Gal4 (c). The bottom images in each panel show
kymographs from Supplementary Video 6 and 7, respectively. The gpr-Gal4 chromosome
has a UAS-GFPtransgene closely linked to the Gal4 transgene, which gives cytoplasmic
GFP background that prevents tracking of EMD-labelled dense-core vesicles. (d) gpr-Gal4
can be used to label small cargoes with red fluorescent proteins. Top image, still image from
Supplementary Video 8 showing Rab4* endosomes that are marked with RFP using this
driver. Bottom image, kymograph from Supplementary Video 8. All images in the figure are
from the arch region of the L1 vein. The retrograde and anterograde directions are towards
the left and right of the images, respectively.
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Table 1
Examples of transgenic fly lines that can be used to label cargoes fluorescently in wing
neurons
Strain Purpose BDSC No.(3) Reference
Drivers:
Appl-Gal4 Pan-neuronal GAL4 expression (chemosensory and 32040 (40)
mechanosensory wing neurons)
dor-Gal4 (b) GAL4 expression in chemosensory neurons 25083 (14)
ela/f155-Gal4 Pan-neuronal GAL4 expression (chemosensory and 458 (41)
mechanosensory wing neurons)
0k371-Gal4 GAL4 expression in glutamatergic neurons 26160 (42)
nSyb-lexA Pan-neuronal LexA expression (chemosensory and 52817 (43)
mechanosensory wing neurons)
Fluorescent reporters (©):

UAS-ANF:.EMD Marks dense-core vesicles 7001 (@)
UAS-App::YFP Marks APP-positive vesicles 32039 8)
UAS-Eb1::GFP Marks growing plus ends of microtubules - (44)
UAS-GalT::RFP Marks Golgi vesicles 30908 Donated to BDSC by J.

Lippincott-Schwartz
UAS-GCaMP5G Intracellular Ca?* reporter 42037 (45)
UAS-GCaMP6F Intracellular Ca?* reporter 42747 (28)
UAS-GFP Marks entire cytoplasm 6658 (46)
UAS-mCD8::GFP General marker of membranes 5130 47)
General marker of membranes 27392 (48; donated to BDSC by

UAS-mCD8::ChRFP (%

UAS-mCDA4:.:tdTomato
UAS-mito::GFP
UAS-mCherry::mito (€)
UAS-Rab4::RFP
UAS-RedStinger::NLS
lexAop-GFP

lexAop-mCherry::mito (6)

Other
tub-Gal80*

General marker of membranes
Marks mitochondria
Marks mitochondria

Marks Rab4-positive endosomes
Marks nuclei
Marks entire cytoplasm

Marks mitochondria

Temperature sensitive version of GAL4 repressor

35837, 35841
8442; 8443

8505
8546

7016

F. Schnorrer)
(49)

(9)
This study
(50)
(51)
(43)
This study

(52)

aBDSC, Bloomington Drosophila Stock Center. See BDSC website for full genotypes;

bcontains a closely linked UAS-GFPtransgene (see Fig. 5b);

CUASand lexAop lines are used with GAL4 and LexA, respectively;

d . . .
also forms some cytoplasmic aggregates even in young flies;

e . . . . . . . S . .
unlike mito::GFP, in which GFP is targeted to the mitochondrial matrix using a sequence from human cytochrome C oxidase subunit VIII,

mCherry::mito is anchored on the mitochondrial outer membrane using the Drosophila Miro transmembrane domain.
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Table 2
Troubleshooting table.

Step Problem Possible reason Solution

17-18  Fly is not stably Too much oil applied Start again with a new fly, reducing amount of oil on the
attached to the coverslip and/or on the wings
coverslip

23 Difficulty focusing on Wing not mounted flat i) Make sure wings are properly extended during
an axonal segment of mounting. ii) Reduce amount of oil on the coverslip and/or
sufficient length on the wings during mounting

Wing is drifting excessively Reduce amount of oil on the coverslip and/or on the wings
during mounting

Fly is moving Keep flies on the CO, pad for longer than 5 min before
mounting

24 Images are dim Laser power, camera gain or exposure time Increase laser power, camera gain and exposure time

is too low accordingly

Fluorescent signal from cargo not bright (i) Try other drivers as these may give higher expression

enough levels. (ii) Try an alternative fluorescent protein (or
concatemers of fluorescent proteins)

25 Few motile cargoes Choice of wing region with relatively few Choose a different area. The number of axons in the
visible in the field of axons proximal L1 vein (wing arch) is greater than in the distal
view L1 vein or L3 vein

Choice of driver that is active in a subset of Use a driver that is active in a broader population of

wing neurons neurons (Table 1)

Cytoplasmic background when using the Use a different driver or a red fluorescent marker protein

apr-Gal4 UAS-GFP chromosome to image

small, green fluorescent cargoes

Fly is not of an optimal age Image flies at 1-2 d after eclosion, when transport of all
organelles imaged to date is robust

36 Too many particles Choice of wing region with a relatively high ~ Choose a different area. The number of axons in the distal
moving makes accurate  number of axons L1 vein or L3 vein is less than in the proximal L1 vein
tracking difficult and (wing arch)
time-consuming

Choice of driver that is active in a broad set Use a driver that is active in a subset of neurons (Table 1)
of wing neurons

39 Large variability in Mounting of flies not performed Practise mounting procedure. Take care not to damage the

transport parameters
between flies of the
same genotype

consistently

Flies imaged are of a different age

Imaging settings are not constant

Changes in temperature

wings during mounting

Pay attention to the timing of eclosion; if required,
establish a cohort of flies that eclosed in a narrow time
window

Keep the same acquisition settings (e.g. laser power,
acquisition time and camera gain) throughout

Keep flies at a constant temperature throughout the
experiment
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